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Resumen: Gracias a la revolución tecnológica que vive el campo de la documentación del patrimonio vemos cómo los registros 3D 
se consolidan como recurso documental y se extienden con infinidad de propósitos, entre ellos los estudios morfométricos. Con la 
intención de contribuir en este campo, proponemos un método encaminado a la detección y cuantificación de cambios formales 
en bienes de naturaleza metálica, un tipo de material susceptible de sufrir daños físicos en un corto período de tiempo. La puesta 
en práctica de dicha metodología se ejemplifica a través del estudio efectuado sobre un casco de hierro del s. XVI, conservado en un 
avanzado estado de mineralización. Fue registrado antes y después de un préstamo temporal apoyándonos en dos sistemas de gran 
difusión en el campo de la digitalización 3D: el escaneado por luz estructurada y la fotogrametría. Finalmente, se compararon sus 
registros mediante la herramienta de análisis de datos 3D CloudCompare para detectar sus posibles diferencias. 
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Processo de registro e monitoração de danos morfológicos em metais arqueológicos através 
da documentação 3D
Resumo: Graças à revolução tecnológica que se vive no campo da documentação do património, vemos os registros 3D a consolidarem-
se como recursos documentais e a estenderem-se com finalidades infinitas, incluindo estudos morfométricos. Com o intuito de 
contribuir neste campo, propomos uma metodologia que visa detetar e quantificar as alterações formais em bens de natureza metálica, 
um tipo de material suscetível a danos físicos num curto espaço de tempo. A implementação desta metodologia é exemplificada 
através do estudo realizado num capacete de ferro do séc. XVI, conservado num avançado estado de mineralização. Foi registado antes 
e depois de um empréstimo temporário baseado em dois sistemas amplamente utilizados na área de digitalização 3D: digitalização 
estruturada de luz e fotogrametria. Finalmente, comparam-se os registos mediante a ferramenta de análise de dados 3D CloudCompare 
para detetar possíveis diferenças. 

Palavras-chave: digitalização 3D, metais, análise computacional, deterioração

Process of recording and tracking morphological damages in archaeological metal through 3D 
documentation
Abstract: Thanks to the outstanding technological revolution that is taking place in the Cultural Heritage documentation field we see how 
3D scanning has consolidated itself as a documentation resource and is expanding its functionality, such as the morphometric analysis. 
With the intention of contributing to this field we offer a methodology and workflow that aims to the detection and quantification of 
formal changes in metallic goods; a material that is susceptible to physical damage in a short span of time. The implementation of this 
methodology is exemplified through a study performed on an XVI century iron helmet, which has been preserved in an advanced state 
of mineralization. It was scanned before and after a temporary loan using two systems that are widely used in the field of 3D scanning: 
structured light scanning and photogrammetry. Both scannings were compared in the end with 3D CloudCompare software, a data 
analysis tool, to detect possible differences.
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control de daños puede aportar información geométrica 
de precisión. En el presente artículo planteamos un 
método enfocado en la detección y cuantificación de 
daños formales en este tipo de bienes con la intención de 
contribuir a definir y ejemplificar sus posibilidades. 

La puesta en práctica de dicha metodología contempla 
dos sistemas de digitalización 3D de gran difusión 
en patrimonio, el escaneado por luz estructurada y la 
fotogrametría. Se ejemplifica a través del estudio efectuado 
sobre un casco de hierro del s. XVI (Fragmento de morrión, 
2012) depositado en el Museo Histórico Militar de Canarias 
(Tenerife) con motivo de su préstamo para participar en 
una exposición temporal. La pieza, de bordes irregulares 
y grosores reducidos, con unas dimensiones de 32 x 38 
cm, se conserva parcialmente en un avanzado estado de 
mineralización [figura 1].

Metodología

Gracias a la destacada resolución y precisión que han 
alcanzado las técnicas de escaneado 3D y fotogrametría, 
desde hace una década campos de estudio como el 
de la geomorfología recurren al análisis de registros 
3D para seguir la evolución de la superficie terrestre 
a través de procesos dinámicos como deslizamientos, 
desprendimientos o procesos erosivos (Lague, Brodu 
y Leroux 2013). Contar con una secuencia de registros 
3D a lo largo de un intervalo de tiempo determinado 
también ofrece un gran potencial analítico para detectar 
y medir la evolución de cambios físicos en cualquier 
tipo de patrimonio material. Interesantes ejemplos de 
aplicabilidad los encontramos en el estudio de grabados 
rupestres (Ruiz et al. 2016) y pinturas murales (Pandey y 
Cather 2015), ambos patrimonio inmueble.

A la hora de trasladar este tipo de análisis morfométricos 
a piezas metálicas debemos contar con información 
geométrica de precisión. Para ello se requiere cuidar la 

Introducción

La revolución digital vivida en los últimos años ha traído 
consigo una importante renovación tecnológica en el 
campo de la documentación del patrimonio cultural. 
Gracias a ello, vemos cómo los registros 3D se consolidan 
como recurso documental y se extienden con infinidad de 
propósitos: documentación arqueológica, preservación 
y conservación digital, restauración virtual, museos 
multimedia, sistemas de información geográfica, y un 
largo etcétera (Remondino 2011).

Sus resultados realistas (en términos de precisión 
geométrica y radiométrica), combinados con medios 
informáticos para exploración de información geométrica 
cuentan también con un gran potencial analítico, en 
vías de desarrollo y normalización. Muchas de estas 
técnicas implican metodologías complejas que requieren 
conocimientos técnicos avanzados, pero otras resultan 
sencillas y son susceptibles de ser aprendidas por 
conservadores-restauradores con una capacitación 
básica en documentación 3D. Es el caso del estudio de 
diferencias geométricas entre registros, una función que 
en el campo del patrimonio se aplica con frecuencia a su 
control de calidad (Menna et al. 2016; Gagliolo et al. 2018; 
Grifoni et al. 2018). También encontramos ejemplos de su 
aplicabilidad para documentar cambios formales, bien 
como seguimiento de una intervención (Rahrig, Torge 
y Assets 2019), bien de procesos de deterioro (Pandey y 
Cather 2015; Ruiz et al. 2016).  

Los metales, que a menudo presentan cierta maleabilidad 
o un estado de corrosión severo, conforman un tipo de 
materiales con una fragilidad matérica destacada y son 
susceptibles de sufrir daños físicos en un período corto 
de tiempo. Para contemplar su seguimiento nos valemos 
de fichas que recogen una descripción precisa de riesgos 
y alteraciones, además de registros fotográficos, mapas 
de daños o mediciones físicas (Díaz y García 2011: 62-
66). La incorporación de información morfométrica en el 

Figura 1.- Morrión español del S.XVI, depositado en el Museo Histórico Militar de Canarias. Autor: Alba Fuentes-Porto.
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metodología de forma que se minimicen las posibles 
diferencias entre digitalizaciones periódicas, y se alcancen 
valores de resolución adecuados al tamaño y detalle 
formal de cada tipo de pieza. En este sentido, definir 
un protocolo de documentación estricto permitirá la 
reproductibilidad tanto de las condiciones de captura 
como del procesamiento de los datos. Además, ayudará 
a adaptar los parámetros del registro a las peculiaridades 
de cada pieza y a maximizar la capacidad de resolución 
de los dispositivos de captura. Es la resolución la que va 
a condicionar nuestra capacidad interpretativa, por lo 
que, siempre que sea posible, es recomendable alcanzar 
valores submilimétricos que posibiliten la detección de 
daños estructurales como fragmentaciones, fracturas o 
incluso delaminaciones de los estratos de corrosión.

—Adquisición de información geométrica 

El escaneo 3D mediante luz estructurada y la fotogrametría 
son dos técnicas empleadas con frecuencia en el registro y 
la documentación del patrimonio. Ofrecen una excelente 
precisión geométrica y permiten generar modelos 3D de 
alta calidad de piezas de pequeña y mediana escala (Bruno 
et al. 2013; Gil-Melitón y Lerma 2018; Morita y Bilmes 2018; 
Marshall et al. 2019).

El escáner de luz estructurada es un dispositivo capaz de 
capturar la forma de un objeto mediante un sistema de 
medición óptica que proyecta patrones de luz y aborda la 
medición trigonométrica de sus distorsiones para calcular 
la profundidad de los puntos inspeccionados (Pieraccini, 
Guidi y Atzeni 2001). Aporta medidas reales de la superficie 
del objeto a escala 1:1, además de una gran resolución y 
precisión 3D. En los dispositivos más extendidos dentro 
de nuestro campo éstas oscilan entre los 0.1/0.5 mm de 
resolución 3D o distancia entre puntos de muestreo, y 
los 0.05/0.1 mm de precisión de puntos (Di Angelo et 
al. 2018; Artec Group 2020). También existen escáneres 
metrológicos de alta precisión, diseñados para el registro 
de piezas pequeñas, que llegan a alcanzar las 30 micras 
(0.03mm) y 10 micras (0.01 mm) respectivamente.

Sin embargo, al tratarse de un método óptico, las superficies 
reflectantes o transparentes plantean dificultades a la 
hora de ser registradas, ya que generan efectos de luz que 
pueden superponerse al de los patrones imposibilitando 
su lectura. Las formas cóncavas, los grosores reducidos y 
las zonas negras o muy oscuras también pueden ocasionar 
vacíos de información (Gupta et al. 2011; Graciano et al. 
2017). Estas limitaciones van a afectar a la hora de registrar 
piezas que conserven su brillo metálico, que presenten 
tonalidades oscuras o que cuenten con incrustaciones de 
cristales o gemas.

La fotogrametría se basa en sofisticados algoritmos 
de coincidencia de imágenes que utilizan fotografías 
superpuestas, adquiridas desde múltiples puntos de 
vista, para reconstruir la geometría tridimensional de un 

objeto o superficie (Aicardi et al. 2018; Vanneschi et al. 
2019: 5). La resolución de los modelos fotogramétricos 
viene determinada por el GSD (Ground Sampling Distance), 
que define cuánto mide un píxel sobre el objeto. Es 
directamente proporcional a la distancia de registro, al 
tamaño y resolución del sensor de la cámara, y a la distancia 
focal empleada (Verhoeven 2018). En la fotogrametría 
de objeto cercano se pueden alcanzar resoluciones 
submilimétricas. Para ello es necesario adquirir un número 
elevado de fotografías con alta redundancia o solape 
(Guidi et al. 2015; Sapirstein 2018), además de acercarse 
lo máximo posible al objeto documentado (Verhoeven 
2019). En la actualidad contamos con guías de buenas 
prácticas para el registro fotogramétrico del patrimonio, 
publicadas por instituciones de referencia, que recogen 
flujos y parámetros de trabajo para una documentación 
geométrica de calidad (Eulac Museums 2013; Historic 
England 2017).

No aporta medidas reales, siendo necesario tomar 
mediciones físicas de referencia para proyectarlas durante 
el procesado de los datos. Sin embargo, ofrece una mayor 
resolución de imagen que las técnicas de escaneado y 
permite implementar procesos de calibración cromática 
con vistas a obtener un registro preciso del color (Ruiz 
y Pereira 2014; Molada-Tebar, Marqués-Mateu y Lerma 
2019). A esto se le suma una considerable accesibilidad 
económica y facilidad de implementación, conjunto 
de cualidades que avala a la fotogrametría como una 
alternativa sólida al escaneo 3D. 

Los efectos de luz que generan las superficies reflectantes 
y los grosores reducidos siguen causando complicaciones 
y produciendo ruido en las lecturas espaciales, pero la 
captura de un número elevado de fotografías solventa 
este problema y aporta un píxel estable y seguro a la hora 
de construir un correcto modelo 3D (Gil-Melitón y Lerma 
2018).

En el caso práctico que se presenta se utilizó como 
dispositivo de luz estructurada un modelo Artec Eva 
(Artec3D), muy extendido en la documentación 3D del 
patrimonio. Ofrece una resolución de 0,5 mm y una 
precisión de 0,1 mm.

Para el levantamiento fotogramétrico se empleó una 
cámara DSLR con un tamaño de píxel de 4.29 µm (modelo 
Canon EOS 700D). Las capturas se realizaron a una distancia 
del objeto de 132 cm, con una focal fija de 47 mm, un 
diafragma f11 e ISO 100. Fueron tomadas 70 fotografías 
de cada lado de la pieza, con una distribución en bucle 
facilitada por una mesa giratoria, formato RAW y máxima 
resolución. El valor GSD alcanzado fue de 0.12 mm/pix, lo 
que supone que cada píxel de las imágenes representa 
0.12 mm de la pieza registrada. 

Las formas semiesféricas y grosores reducidos del casco 
suelen dificultar las labores de alineado en ambas técnicas. 
Para contrarrestarlo, durante el proceso de escaneado se 
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Los sistemas de escaneado 3D cuentan con su propio 
software de procesado de datos y suelen presentar 
flujos de trabajo típicos: escaneo o adquisición de datos, 
registro y alineado de escaneos, eliminación de ruido e 
información superflua, generación y diezmado de malla, 
generación y optimización de texturas, exportación en 
diferentes formatos, visualización e incluso realización de 
mediciones sencillas.

Como software de procesado fotogramétrico disponemos 
de varias opciones con un amplio abanico de prestaciones 
y precios, existiendo también herramientas gratuitas 
(Kingsland 2019). Hoy en día, Agisoft Metashape (Agisoft) 
es una de las más empleadas en la documentación 
3D del patrimonio cultural y sus evaluaciones afirman 
su fiabilidad y reproducibilidad en reconstrucciones 
digitales (Kingsland 2019). Su flujo de trabajo estándar 
contempla la calibración de cámara, alineado de 
fotografías y generación de puntos de paso, la creación 
de mapas de profundidad y de nube de puntos densa, la 
eliminación de información superflua y filtrado de ruido, 
el mallado, el alineado y unión de bloques, el texturizado 
y la exportación.

En ambos casos, el software de procesado se actualiza de 
forma constante incorporando mejoras en sus algoritmos 
y en sus prestaciones. Por ello, conviene guardar los 
archivos en bruto y reprocesarlos a la hora de hacer 
seguimientos a largo plazo. 

En el caso que se presenta, los registros realizados por 
escaneado mediante luz estructurada se procesaron 
utilizando el software Artec Studio Professional V.10 
(Artec3D) con los valores predeterminados para una 
edición de alta calidad [figura 7].

Con vistas a reflejar flujos de trabajo actuales, los 
registros fotográficos fueron reprocesados con la versión 
de Agisoft Metashape V.1.6.4 Standard Edition (Agisoft), 
lanzada en 2020. Como paso previo se realizó un revelado 
RAW contemplando su calibración cromática. Para ello 
se ajustó la curva tonal con la ayuda de una carta de 
color X-Rite ColorChecker Passport (X-Rite/Pantone) 
siguiendo la metodología detallada por Santos (2014), y 
se exportaron a formato JPG. A continuación, en Adobe 
Photoshop V.22.0 (Adobe) se enmascararon las imágenes 
en el canal alfa con el fin de focalizar la detección 
de puntos de paso y puntos clave sobre el objeto. A 
continuación, los archivos fueron importados al software 
de procesado, en el que se realizó un flujo de trabajo tipo 
[figura 7].

Agisoft Metashape (Agisoft) incorpora la opción de 
estimar el nivel de confianza de los puntos a la hora 
de generar la nube de puntos densa. Esto, unido a 
las herramientas de filtrado por nivel de confianza, 
permitió eliminar el ruido con destacada eficiencia y 
alcanzar registros más depurados y coherentes [figura 
3].

dispusieron un conjunto de dianas. Además, el área de la 
cresta nos permitió digitalizar de forma simultánea zonas 
de su anverso y su reverso, lo que proporcionó datos con 
superficies parciales en ambos lados e hizo posible registrar 
su espesor. Sin embargo, bordes y lagunas no se lograron 
registrar adecuadamente debido a su irregularidad y 
finura. En el levantamiento fotogramétrico la pieza se 
colocó sobre un pequeño pedestal para potenciar la 
visibilidad de sus dos caras [figura 2].

Figura 2.- Disposición de ambos lados de la pieza en el registro 
fotogramétrico. Autor: Alba Fuentes-Porto.

—Procesado de registros 3D

A la hora de emplear modelos 3D con fines analíticos, 
conviene configurar los parámetros de edición a máxima 
calidad para maximizar su precisión y resolución 
geométrica. Mientras que los modelos de mallas 
texturizados son los más adecuados para proporcionar 
una representación realista de la superficie, las nubes de 
puntos se adecúan mejor a los análisis morfométricos, 
ya que eluden la simplificación de zonas, se reduce el 
procesado de los datos y ayudan a acelerarlo durante las 
tareas de optimización y análisis. Un aspecto que se debe 
cuidar es la correcta ubicación de las normales, vectores 
perpendiculares a la geometría registrada que determinan 
la orientación de la superficie. Si estas no se corresponden 
con la realidad física del objeto generarán errores de 
lectura.
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Figura 3.- Ejemplo del filtrado por nivel de confianza de uno de los registros fotogramétricos. Izda.) Selección de valores inferiores a 
20. Dcha.) Nube de puntos tras su eliminación. Autor: Alba Fuentes-Porto.

En todos los registros, las nubes de puntos fueron 
exportadas en formato PLY (.ply), tipo de archivo que 
guarda las coordenadas geométricas, color y normales 
de cada uno de los vértices. Por último, se comprobó 
la coherencia geométrica de los registros mediante la 
constatación de la correcta orientación de sus normales. 
Esto se hizo en MeshLab v.2020.07 (MeshLab), software 
gratuito que cuenta con un interesante conjunto de 
herramientas para limpiar, reparar e inspeccionar datos 
3D. El proceso consistió en dos sencillos pasos, cuyos 
comandos se facilitan en inglés por ser el único idioma del 
software:

1. Filters > Normals, Curvatures and Orientation > 
Compute normals for point sets 
2. Render > Show Normal [figura 4].

Figura 4.- Visualización de la orientación y longitud de las 
normales en MeshLab. Autor: Alba Fuentes-Porto.

Si no figuran las normales o están mal orientadas podemos 
corregirlas, asegurándonos que guardamos estos atributos 
de forma correcta al exportar el archivo:

3. Filters > Normals, Curvatures and Orientation > Compute 
normals for point sets.

—Análisis morfométrico

CloudCompare V.2.11.3 (Proyecto CloudCompare) es una 
aplicación gratuita y de código abierto dirigida al procesado 
y análisis geométrico de modelos 3D (Girardeau-Montaut 
2006). Cuenta con tres herramientas para detectar las 
diferencias y computar las distancias existentes entre dos 
registros:

• Cloud to Mesh Distance (C2M) computa las distancias 
entre una nube de puntos y una malla (Girardeau-Montaut 
2015b).

• Cloud to Cloud Distance (C2C) computa las distancias 
entre dos nubes de puntos. Para cada punto de la nube 
comparada, el software busca el punto más cercano en 
la nube de referencia y calcula su distancia (Girardeau-
Montaut 2015a).

• Multiscale Model to Model Cloud Comparison (M3C2) 
también opera directamente sobre nubes de puntos, pero la 
distancia se calcula a lo largo de la dirección de las normales 
(Lague, Brodu y Leroux 2013; Girardeau-Montaut 2019).

Autores del ámbito de la teledetección consideran que M3C2 
es la herramienta más adecuada para resolver la detección 
de pequeños cambios por hacer un tratamiento matizado 
de los datos (Barnhart y Crosby 2013: 2828). Sin embargo, 
la configuración de sus parámetros requiere conocimientos 
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técnicos avanzados; mientras que C2C ofrece un entorno 
más sencillo e intuitivo, a la vez que proporciona “distancias 
verdaderas” siempre que la nube de referencia cuente con 
una densidad suficiente. Ambas características nos llevan a 
estimar esta opción como la alternativa más adecuada para 
un uso generalizado y es la que se recoge a continuación.

El punto de partida para analizar una pareja de registros 
3D consiste en hacer que pasen a ocupar un mismo 
espacio, a partir del cual poder computar las diferencias. 
Es un procedimiento indispensable para no generar falsos 
resultados por discordancias en la orientación de ambos 
modelos. Se consigue mediante su alineado y registro, 
siendo conveniente tomar como referencia siempre la nube 
de puntos más densa:

1. Tools > Registration > Match bounding-box centers.
2. Tools > Registration > Align (por selección de pares de 
puntos).
3. Tools > Registration > Fine registration. Este proceso 
permite ajustar la escala entre un par de modelos, 
opción que conviene activar en los fotogramétricos para 
eliminar cualquier diferencia que pudiera ocasionar su 
escalado manual.

Una vez conseguida la coherencia geométrica se procede 
a calcular las diferencias morfométricas. El propio software 
estima los parámetros que mejor se adecúan al cálculo, por 
lo que el comando se puede ejecutar de forma directa:

4. Tools >Distances > Cloud/Cloud Dist. 

Para el análisis de los posibles cambios originados en el 
morrión se usó el registro de vuelta tanto en el escaneado 
como en la fotogrametría, y se aplicó la herramienta con los 
parámetros preestablecidos [figuras 5 y 6].

Figura 5.- Registros 3D de salida (izda.) y entrada (dcha.) 
adquiridos mediante escaneado por luz estructurada (a, b) y 
fotogrametría (c,d). Autor: Alba Fuentes-Porto.

Figura 6.- Selección de la nube de referencia tras el alineado de 
modelos fotogramétricos. Autor: Alba Fuentes-Porto.

Figura 7.- Flujo de trabajo seguido: adquisición de información 
geométrica, procesado de datos 3D, y análisis morfométrico. 
Autor: Alba Fuentes-Porto.  
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Realizado el cálculo, se proyectan diferencias geométricas 
sobre la nube analizada, que son resaltadas por medio de 
una codificación cromática. Su apariencia es configurable 
a través de la ventana de propiedades. También cuenta 
con la posibilidad de añadir una escala numérica con los 
valores cuantitativos de las distancias, y un histograma. Este 
gráfico nos permite estudiar su tendencia y distribución 
con más detalle. Ambos elementos se pueden activar con 
los comandos:

5. Display > Active scalar field > Toggle color scale
6. Edit > Scalar Fields > Show Histogram

La capacidad de análisis dependerá de la resolución de 
los registros. A la hora de interpretar los resultados será 
necesario buscar tendencias locales. Es probable que los 
resultados abarquen valores de distancias elevados, pero 
suelen deberse a puntos de ruido aislados.

Resultados

Los cambios significativos que se detectan entre los registros 
adquiridos con el escáner de luz estructurada se disponen 
exclusivamente a lo largo del perímetro de la pieza, zona 
que no había sido registrada convenientemente y carece 
de datos sólidos. Si recurrimos al histograma del análisis 

Figura 8.- Mapa de diferencias e histograma. Reflejan los 
resultados del análisis sobre los escaneados. Autor: Alba 
Fuentes-Porto.

morfométrico, podemos observar que estas diferencias 
se concentran, en pequeñas tendencias locales de cierta 
entidad, entre los 0.8 mm y los 2 mm. El interior de la pieza 
no registra ningún cambio significativo, mientras que la 
curva de distribución muestra una tendencia homogénea 
hasta los 0.8 mm, valores que nos llevan a determinar que 
no se han producido ganancias o pérdidas de material por 
encima de estas medidas [figura 8].

Los registros fotogramétricos no alertan de ningún 
cambio, incluido el perímetro de la pieza, registrado de 
forma correcta. Su curva de distribución muestra una 
tendencia homogénea hasta los 0.4 mm. La ausencia de 
tendencias locales en las diferencias halladas por encima 
de los 0.4 mm subraya que no se ha detectado ningún 
cambio significativo [figura 9].

Figura 9.- Mapa de diferencias e histograma. Reflejan los 
resultados del análisis sobre los registros fotogramétricos. Autor: 
Alba Fuentes-Porto.

Discusión

El caso práctico presentado refleja cómo los modelos 
3D y el análisis espacial pueden contribuir a optimizar el 
seguimiento formal de piezas metálicas, ya que aportan 
documentación geométrica de precisión dotada de 
información cuantitativa. Además, hoy en día, ciertos 
procesadores y lectores de texto contemplan la inserción 
de este tipo de imágenes. Esto nos permite integrarlas en 
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desarrollo del proyecto, una limpieza basada en métodos 
manuales no nos facilitó un depurado eficiente de ruido 
(Fuentes-Porto, Díaz-Aleman y Díaz-González 2020), labor 
que hizo posible la incorporación de las herramientas de 
estimación y filtrado por nivel de confianza de puntos que 
incorporó Agisoft Metashape (Agisoft). También se alcanzó 
una destacada resolución, definida por un GSD de 0.12 
mm/pix.

Es innegable que los registros 3D son, en la actualidad, el 
mejor método de obtención de mediciones muy precisas. 
Esto no nos exime de que, en función de las características 
formales de cada pieza, los recursos tecnológicos y los 
tiempos de trabajo de los que dispongamos, podamos 
encontrarnos con limitaciones técnicas que deriven 
en lagunas documentales o precisiones inferiores a las 
esperadas. En ese caso, siempre debemos ajustarnos a 
los datos sólidos, que enriquecerán nuestra capacidad 
interpretativa por limitados que sean.

Conclusiones

El desarrollo y los resultados de este trabajo experimental 
subrayan la aplicabilidad de las técnicas geomáticas 
en el seguimiento y monitorización formal de piezas 
metálicas. Siguiendo una metodología cuidada, registros 
adquiridos mediante escaneado de luz estructurada o 
fotogrametría han posibilitado análisis geométricos de 
precisión submilimétrica capaces de cuantificar cambios 
volumétricos a lo largo de un intervalo temporal. La 
incorporación de información morfométrica en los 
protocolos de control de daños contribuye a minimizar la 
subjetividad de valoraciones técnicas que hasta la fecha se 
respaldaban en la comparación de registros fotográficos, 
mapas de daños o mediciones físicas. La accesibilidad y 
sencillez de la metodología favorece la normalización de 
este tipo de procedimientos, pero es necesario que toda 
interpretación se ajuste a datos sólidos. 
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